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Introduction

What is ActiveSync®?
The Microsoft® ActiveSync® is one of the important bundled programs in
MyPal. With ActiveSync, you can synchronize the information on your
desktop computer with the information on your device. Synchronization
compares the data on your device with your desktop computer and
updates both computers with the most recent information.

For example:

• Keep Pocket Outlook data up-to-date by synchronizing your device with
Microsoft Outlook data on your desktop computer.

• Synchronize Microsoft Word and Microsoft Excel files between your
device and desktop computer. Your files are automatically converted to
the correct format.

NOTE By default, ActiveSync does not automatically synchronize all
types of information. Use the ActiveSync options to turn
synchronization on or off for specific information types.

With ActiveSync, you can also:

• Back up and restore your device data

• Copy (rather than synchronize) files between your device and desktop
computer

• Control when synchronization occurs by selecting a synchronization
mode. For example, you can synchronize continually while connected to
your desktop computer or only when you choose to synchronize.

• Select which information types are synchronized and control how much
data is synchronized. For example, you can choose to synchronize your
appointments of the past two weeks only, appointments older than two
weeks are not synchronized.

For more information about using ActiveSync:

1. Start ActiveSync on your desktop computer.

2. From the Activesync menu bar, click Help then on Microsoft
ActiveSync Help.
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Installing ActiveSync®

The ActiveSync program is already installed on your device. To
synchronize information on your device with your computer, you must also
install ActiveSync on your computer. Install ActiveSync from the
Companion CD that came with your product package.

NOTE Before starting the ActiveSync installation, make sure that
you have Microsoft® Outlook® installed on your computer. If
you do not have Outlook, install the Microsoft® Outlook® 2002
from the Companion CD. Even if you have Outlook 98 or
Outlook 2000 installed, you are encouraged to update to
Outlook 2002.

Installing ActiveSync® on your computer

To install ActiveSync on your computer:

1. Turn on your computer and monitor.

NOTE Do not connect your device to your computer until you have
finished installing ActiveSync.

2. Insert the Companion CD into the CD-ROM drive of your computer.
The CD autoruns and displays the initial screen, then the Main Menu
from which you can start the installation.

3. Click on Start Here from the Main Menu.
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4. Read the Overview before
installing ActiveSync 3.7 to make
sure that you perform the
installation sequence correctly.

5. If you have not installed Outlook,
install it now. Click Install
Outlook 2002 and follow the
screen instructions to complete
the installation.

6. Click Download Connection
Wizard and read the overview to
see if you require the wizard.
Follow the screen instructions to
install the wizard on your
computer. Return to the Main
Menu when done.

7. Click Install ActiveSync 3.7,
then click Install.

8. When prompted, select Run this
program from its current
location then click OK.

9. Follow the succeeding screen
instructions. Click Finish to
complete the installation.

10. Restart Windows when prompted,
then proceed to the next section
to connect your device to your
computer and start
synchronization.
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Synchronizing your device

Connecting your device to a computer

To connect your device to your computer:

1. Place the device on the cradle.

2. Connect the AC adapter to the power connector on the cradle.

3. Connect the USB sync cable from the cradle to a USB port on your
computer.

To connect your device to
your computer without the
cradle:

1. Connect the traveling USB sync
cable with 26-pin connector to the
26-pin  connector at the bottom of
the device.

2. Connect the other end of the cable
to a USB port on your computer.

26-pin connector
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Setting up a partnership
Immediately after you have completed the installation, the New
Partnership wizard will start automatically to help you establish a
partnership and customize your synchronization settings. At this point, you
can decide exactly which types of information you would like to
synchronize with your computer.

A partnership is a file that allows you to synchronize your device
with your desktop computer. This file is stored on your desktop
computer. An additional file that enables your desktop computer to
recognize your device is stored on your device.

2. On the next screen, select
Synchronize with the desktop
computer. Click Next.

3. Select the type of information that
you wish to synchronize. Click
Next.

OR

If you wish to customize a
synchronized item, highlight the
item then click Settings.

To set up a partnership:

1. When the New Partnership
screen appears, select Standard
partnership for the type of
partnership to establsih between
your device and your computer.
Click Next.
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On the Calendar
Synchronization Settings
window, for example, select from
the options how you wish to
synchronize the appointments on
your device with your computer.
Click OK.

4. Click Finish to complete setting a
partnership.

Immediately after you set up a
partnership, ActiveSync® starts
automatically and initiates the first
synchronization between your
device and your computer.

Refer to the succeeding sections
for more details on
synchronization.
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Checking synchronized information
After your first synchronization, take a look at Calendar, Contacts, and
Tasks on your device. You will notice that the calendar information in
Microsoft Outlook on your computer was copied to your device, and the
information that you have on your device was copied to your computer.

NOTE Open Microsoft Outlook on your desktop computer to see the
details of copied information from your device.
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Manually initiating synchronization
Once you have set up ActiveSync and completed the first synchronization
process, you can initiate synchronization from your device at any time.

To manually initiate synchronization:

1. Tap  , then tap ActiveSync to display the ActiveSync screen.

2. To start synchronization, make a connection between your device and
your computer, then tap Sync.

To end synchronization, tap Stop.

For more information on synchronization:

Tap   while in the ActiveSync screen, then tap Help.

Connection status
Tap to connect and synchronize
Tap to stop synchronization

Tap to synchronize via IR or
change synchronization settings
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Synchronization options
The Microsoft ActiveSync program allows you to customize your
synchronization settings at any time. You can select the items to
synchronize, set the synchronization schedule, and specify the
synchronization rules.

To display the synchronization options:

• From the ActiveSync window on your desktop computer, click on the
Options icon, or

• From the menu bar, click on Tools, then Options.

1. Check the box opposite the item
that you wish to synchronize.

2. Highlight a checked item then
click on Settings to specify
synchronization options for the
item.

For example, highlight Calendar
then click on Settings to display
the Calendar Synchronization
Settings window. Customize the
available settings, then click OK
when done.

3. Do the same for the other
checked items.

NOTE:  You cannot set the
options for unchecked items.

4. Click OK when done.

To select items to synchronize:
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To set synchronization schedule:

1. Click on the Schedule tab.

2. Select your desired
synchronization schedule.

3. Click OK when done.

To specify synchronization rules:

1. Click on the Rules tab.

2. Select your desired settings from
the available options.

3. Click OK when done.
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Introduction
Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and
Notes. You can use these programs individually or together. For example,
e-mail address stored in Contacts can be used to address e-mail
messages in Inbox.

Using ActiveSync®, you can synchronize information in Microsoft Outlook
or Microsoft Exchange on your desktop computer with your device. You
can also synchronize this information directly with a  Microsoft Exchange
server. Each time you synchronize, ActiveSync compares the changes you
mode on your device and desktop computer or server and updates both
computers with the latest information. For information on using ActiveSync,
see ActiveSync Help on your desktop computer.

You can switch to any of the Pocket Outlook programs by tapping .

Calendar:  Scheduling appointments
and meetings

Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views
(Agenda, Day, Week, Month, and Year) and easily switch views using the
View menu.

NOTE You can customize the Calendar display, such as changing
the first day of the week, by tapping Options on the Tools
menu.

Tap to go to Today

Tap to display or edit the
appointment details

Tap to create a new appointment
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Creating appointments

To create an appointment:

1. If you are in Day or Week view, tap your desired date for the
appointment,

2. Tap New.

3. Using the input panel, enter a description and a location. Tap to select
the field.

4. If needed, tap the date and time to change them.

5. Enter other desired information. You will need to hide the input panel to
see all available fields.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see the “Notes:
Capturing thoughts and ideas” later in this chapter.

7. When done, tap OK to return to Calendar.

NOTE If you select Remind me in an appointment, your device will

remind you according to the options set in , Settings,
Personal tab, Sounds and Notifications.

Tap to select from a predefined text
Tap to select from previously
entered locations
Tap to specify the time of appointment
Tap to specify the date of appointment

Tap to add notes to the appointment
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Using the summary screen
When you tap an appointment in Calendar, a summary screen appears. To
change the appointment, tap Edit.

Creating meeting requests
You can use Calendar to set up meetings with users of Outlook and
Pocket Outlook. The meeting request will be created automatically and
sent either when you synchronize Inbox or when you connect to your
e-mail server.

To create a meeting request:

1. Tap Tools then Options to indicate how you want meeting requests
sent.

2. If you send and receive e-mail messages through ActiveSync, select
ActiveSync.

To schedule a meeting:

1. Create an appointment.

2. In the appointment details, hide the input panel, then tap Attendees.

3. From the list of e-mail addresses you have entered in Contacts, select
the meeting attendees.

The meeting notice is created automatically and place in the Outbox
folder. For more information on sending and receiving meeting
requests, see Calendar Help and Inbox Help on the device.

Appointment details

Notes/additional information
on the appointment

Tap to change details of the appointment
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Contacts:  Tracking friends and
colleagues

Contacts maintains a list of your friends and colleagues so that you can
easily find the information you look for, whether you are at home or on the
road. Using the infrared port (IR) on the device, you can quickly share
Contacts information with other device users.

NOTE To change the way information is displayed in the list, tap
Tools then Options.

Tap and enter part of a name
to quickly find it on the list

Tap to select the category of
contacts you want to display

Tap to display additional phone
numbers and email addresses

Tap to display or edit the contact details

Tap to create a new contact

Tap to sort contacts by name or company

Tap an action for a selected contact
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Creating contacts

To create a contact:

1. Tap  , then tap Contacts.

2. Tap New to display a blank
contact form.

3. Using the input panel, enter a
name and other contact
information. You will need ot scroll
down to see all available fields.

4. To assign the contact a category,
scroll to and tap Categories, then
select a category from the list. On
the contact list, you can display
the contacts by category.

Using the summary screen
Tapping a contact on the contact list displays a summary screen. To
change the contact information, tap Edit.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing thoughts and ideas” later in this chapter.

6. Tap OK to return to the contact list when done.

Contact details

Tap to display notes

Tap to change contact information
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Finding a contact
There are four ways to find a contact.

1. On the contact list, enter a contact
name in the box under the
navigation bar. To show all contacts
again, clear text from the box or tap
the button to the right of the box.

2. In the contact list, tap the category
list (labeled All Contacts by
default) and select the type of
contact that you wish to display. To
show all contacts again, select All
Contacts. To view a contact not
assigned to a category, select
None.

3. To view the names fo companies
your contacts work for, in the
contact list, tap View > By
Company. The number of contacts
that work for that company will be
displayed to the right of the
company name.

4. Tap  , Find, enter the contact
name, select Contacts for the type,
and tap Go.

1

2

3

4
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Tasks:  Keeping a to do list
Use Tasks to keep track of what you have to do.

Creating tasks

To create a task:

1. Tap  , then tap Tasks.

2. Tap New to display a blank task
form.

3. Using the input panel, enter a
description.

4. Enter a start date and due date,
or enter other information by
tapping the field first. If the input
panel is open, you will need to
hide it to see all available fields.

Tap to select a sort
order of the task list

Tap to select the category of
tasks you want to display

Indicates high priority

Tap to display or edit
the task details

Tap and hold to display a
pop-up menu of actions

Tap an action for the task

Tap to create a new task
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5. To assign the task to a category, tap Categories and select a category
from the list. On the task list, you can display tasks by category.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing thoughts and ideas” later in this chapter.

7. Tap OK to return to the task list when done.

Using the summary screen
Tapping a task on the task list displays a summary screen. To change the
task details, tap Edit.

TIP To quickly create a task with
only a subject, tap Entry Bar on
the Tools menu. Tap Tap here
to add a new task and enter
your task information.

Task details

Tap to show or hide the task details

Notes/additional information on the task

Tap to change the task details
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Notes:  Capturing thoughts and
ideas

Quickly capture thoughts, reminders, ideas, and phone numbers with
Notes. You can create a written note or a recording. You can also include a
recording in a note. If a note is open when you create the recording, it will
be included in the note as an icon. If the note is displayed, it will be
created as a stand-alone recording.

Tap to change the sort order of the list

Tap to open a note or play a recording

Tap to record

Tap to show or hide the recording toolbar

Tap to create a new note or recording

Tap and hold to display a
pop-up menu of actions

Tap an action for the item

You may change the default Notes options including the writing mode,
template, file storage, and record button action.

To change the Notes options:

1. Tap  , then tap Notes.

2. Tap Tools, then Options... to
display the options screen.

3. Make your desired changes.

4. Click OK.
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Creating notes

To create a note:

1. Tap  , then tap Notes.

2. Tap New to display a blank note.

3. Create your note by writing, drawing, typing, or recording. For more
information about using the input panel, writing and drawing on the
screen, and creating recordings, see Chapter 2.

Tap to show or hide
the input panel

Tap to save the note and
return to the Notes list

Tap to write on the screen

Tap to add a recording to the note
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Inbox:  Sending and receiving e-mail
messages

Use Inbox to send and receive e-mail messages in one of these ways:

• Synchronize e-mail messages with Microsoft Exchange of or Microsoft
Outlook on your desktop computer

• Send and receive e-mail messages by connecting directly to an e-mail
server through an Internet service provider (ISP) or a network

Synchronizing e-mail messages
E-mail messages can be synchronized as part of the general
synchronization process. You will need to enable Inbox synchronization in
ActiveSync. For more information on enabling Inbox synchronization, see
ActiveSync Help on your desktop computer.

During synchronization:

• Messages are copied from the mail folders of Exchange or Outlook on
your desktop computer to the ActiveSync folder in Inbox on your device.
By default, you will receive messages from the past three days only, the
first 100 lines of each message, and file attachments of less than 100KB
in size.

• E-mail messages in the Outbox folder on your device are transferred to
Exchange or Outlook, then send from those programs.

• E-mail messages in subfolder must be selected in ActiveSync on your
desktop computer in order to be transferred.

NOTE You can also synchronize e-mail messages with your desktop
computer from a remote location. For more information, see
Chapter 7.
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Connecting directly to an e-mail server
In addition to synchronizing e-mail messages with your desktop computer,
you can send and receive e-mail messages by connecting to an e-mail
server using a modem or network card connected to your device. You
need to set up a remote connection to a network or an ISP, and a
connection to your e-mail server. For more information, see Chapter 7.

When you connect to the e-mail server, new messages are downloaded to
the device Inbox folder, messages in the device Outbox folders are sent,
and messages that have been deleted on the e-mail server are removed
from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your
e-mail server rather than your desktop computer. When you delete a
message on your device, it is also deleted from the e-mail server the next
time you connect based on the settings you selected in ActiveSync.

You can work online or offline. When working online, you read and
respond to messages while connected to the e-mail server. Messages are
sent as soon as you tap Send, which saves space in your device.

When working offline, once you have downloaded new message headers
or partial messages, you can disconnect from the e-mail server and decide
which messages to download completely. The next time you connect,
Inbox downloads the complete messages you have marked for retrieval
and sends the messages you have composed.
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Using the message list
The messages you receive are displayed in the message list. By default,
the most recently received messages are displayed first in the list.

When you receive a message, tap it to open. Unread messages are
displayed boldface.

Tap to select the sort order
for the messages

Tap and hold to display a
pop-up menu of actions

Tap to connect, and to send/receive e-mail

Tap to connect to the selected service

Tap to select the service, and the
folder that you wish to display

Tap to return to the message list

Tap to delete this message

Tap to reply to or forward this message

Tap to view the next message

Tap to view the previous message
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When you connect to your e-mail server or synchronize with your desktop
computer, by default, you will receive messages from the last five days
only, the first 100 lines of each new messages, and file attachments of less
than 100KB in size. The original messages remain on the e-mail server or
your desktop computer.

You can mark the messages that you want to retrieve in full during your
next synchronization or e-mail server connection. In the message list, tap
and hold the message that you want to retrieve. On the pop-up menu, tap
Mark for Download. The icons in the Inbox message list give you visual
indications of message status.

You can specify your downloading preferences when you set up the
service or select your synchronization options. You can change them at
any time.

• Change options for Inbox synchronization using ActiveSync options. For
more information, see ActiveSync Help on your desktop computer.

• Change options for direct e-mail server connections in Inbox on your
device. Tap Tools then Options. On the Service tab, tap the service that
you wish to change. Tap and hold the service and select Delete to
remove a service.
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Composing messages

To compose a message:

1. Tap New.

2. In the To field, enter an e-mail or SMS address of one or more
recipients, separating them with a semicolon, or select a name from
the Contacts list by tapping the Address Book button. All e-mail
addresses entered in the e-mail fields in Contacts appear in the
Address Book.

3. Compose your message. To enter
preset or frequently used
messages, tap My Text and
select a message.

4. Tap Send when you have finished
the message. If you are working
offline, the message is moved to
the Outbox folder and will be sent
the next time you connect.

Tap to show or hide the
complete message header

Tap to send the message

Tap to select a preset message
Tap to display the e-mail address book

Tap to show or hide the recording toolbar
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Managing e-mail messages and folders
The behavior of the folders you create depends on whether you are using
ActiveSync, SMS, POP3, or IMAP4.

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will
automatically be sunchronized with your device. You can select to
synchronize additional folders by designating them for ActiveSync. The
folders you create and the messages you move will then be mirrored on
the server. For example, if you move two messages from the Inbox folder
to a folder named Family, and you have designated Family for
synchronization, the server creates a copy of the Family folder and
copies the messages into that folder. You can then read messages while
away from your desktop computer.

• If you use SMS, messages are stored in the Inbox folder.

• If you use POP3 and you move e-mail messages to a folder you created,
the link is broken between the messages on the device and their copies
on the mail server. The next time you connect, the mail server will see
that the messages are missing from the device Inbox and delete them
from the server. This prevents you from having duplicate copies of a
message, but it also means that you will no longer have access to
messages that you move to folders created from anywhere except the
device.

• If you use IMAP4, the folders you create and the e-mail messages you
move are mirrored on the server. Therefore, messages are available to
you anytime you connect to your mail server, whether it is from your
device or desktop computer. This synchronization of folders occurs
whenever you connect to your mail server, create new folders, or
rename/delete folders when connected.
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The companion programs consist of Microsoft® Pocket Word, Microsoft®

Pocket Excel, MSN Messenger, Windows Media™ Player for Pocket PC,
and Microsoft® Reader.

To switch to a companion program on your device, tap Programs on the
 menu, then tap the program that you wish to open.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to give
you easy access to copies of your documents. You can create new
documents on your device, or you can copy documents from your desktop
computer to your device. Synchronize documents between your desktop
computer and your device so that you have the most up-to-date content in
both locations.

Use Pocket Word to create documents, such as letters, meeting minutes,
or trip reports.

1. Tap  , tap Programs, tap
Pocket Word to launch the
application.

If you have existing Microsoft
Word or Pocket Word documents
in your device, a list of the
documents appears.

Creating Pocket Word documents

To create a new Word document:

NOTE If you selected a template for new documents in the Options
dialog box, that template appears with the appropriate text
and formatting already provided.
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2. Tap New to display a blank document.

3. Use any of the tools in the input panel to type your text.

Type your text here

Tap to select an input method

Tap to show or hide the input panel

Tap to show or hide the formatting toolbar

Tap to save and close your document

Formatting toolbar

Saving Pocket Word documents

To save a Pocket Word document:

When you have finished editing your document, tap OK.

The document is saved using the first line as file name if you did not
specify a file name. For example, if your first line in the document has
the words Bits-n-Pieces, these words appear in your Word documents
list.
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To specify save options:

1. With the document open, tap
Tools.

2. From the pop-up menu, tap Save
Document As... to display the
Save As screen.

3. Change the file name by simply
typing a new one in the Name
field.

4. Tap the down arrow in the Folder
field to select a folder where you
wish to place the file.

NOTE If you do not wish to change the document format, but would
like to change the file name, folder, and location of your
document, simply tap Edit from the command bar, then tap
Rename/Move... from the pop-up menu to make your
changes.

5. Tap the down arrow in the Type field to select a file format.

You can save the document you create or edit in a variety of formats:

• Word (.doc)

• Pocket Word (.psw)

• Rich Text Format (.rtf)

• Plain Text (.txt)

6. Tap the down arrow in the Location field to indicate the location of
your saved file, either in the main memory of your device, or in a
storage card, if available.

7. Tap OK when done.



Companion programs 5-5

Opening an existing Pocket Word document
Pocket Word contains a list of the files stored on your device. Tap a file in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

NOTE You can open only one Pocket Word document at a time;
when you open a second document, you will be asked to
save the first.

Tap to select the folder you want to display

Tap to change the sort order of the list

Tap to open a document

Tap to create a new document

Tap to change document settings



5-6 Chapter 5

Modes of entering information
You can enter information in Pocket Word in one of four modes (typing,
writing, drawing, or recording), which are displayed on the View menu.
Each mode has its own toolbar that you can show or hide by tapping the
Show/Hide Toolbar button on the command bar.

If you are opening a Word document created on a desktop computer,
select Wrap to Window on the View menu so that you can see the entire
document.

To change the zoom magnification:

1. Tap View, then tap Zoom.

2. Select your desired percentage.

Select a higher percentage to enter text and lower one to see more of
your document.

Typing Mode

Using the input panel, enter typed text into the document. For more
information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. You can select
text as you do in a Word document, using your stylus instead of the mouse
to drag through the text you want to select. You can search a document to
find text by tapping Edit and Find/Replace.
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Writing mode

In writing mode, use your stylus to write directly on the screen. Ruled lines
are displayed as a guide, and the zoom magnification is greater than in
typing mode to allow you to write more easily. For more information on
writing and selecting writing, see Chapter 2.

NOTE If you cross three ruled lines in a single stylus stroke, the
writing becomes a drawing, and can be edited and
manipulated as described in the next section.

Written words are converted to graphics (metafiles) when a
Pocket Word document is converted to a Word document on
your desktop computer.

Write your text here

With the Space button selected,
drag to insert space. An arrow
appears showing the space
direction direction and size.

Tap to show or hide the writing/formatting toolbarPen button

Space button

Tap to display the menu

Tap to display zoom percentages

Tap to wrap text to screen
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Drawing mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear
as a guide. When you lift your stylus off the screen after ther first stroke,
you will see a drawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see
Chapter 2.

Recording mode

In recording mode, embed a
recording into your document.
Recordings are saved as .wav files.
For more information on recording,
see Chapter 2.

Resize an object by dragging
the selection handles

Tap an arrow to display the options
Pen button

Drawing toolbar

Tap to show or hide the drawing toolbar

Tap to select the formatting options

Embedded recording
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Pocket Excel
Pocket Excel works with Microsoft Excel on your desktop computer to give
you easy access to copies of your workbooks. You can create new
workbooks on your device, or you can copy workbooks from your desktop
computer to your device. Synchronize workbooks between your desktop
computer and your device so that you have the most up-to-date contents
in both locations.

Use Pocket Excel to create workbooks, such as expense reports and
mileage logs.

Pocket Excel contains a list of the files stored on your device. Tap a file in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting, and filtering. To display the toolbar, tap View, then tap
Toolbar.

NOTE You can open only one Pocket Excel document at a time;
when you open a second document, you will be asked to
save the first.

Cell contents appear here as you
type, or when you select the cell

Zoom button

Format button

AutoSum button
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Saving Pocket Excel documents

To save an Excel document:

When you have finished editing your document, tap OK.

By default, your document is saved as Book1 as file name. You can
change the file name to one that is more descriptive of your document.
See next section for saving options.

1. Tap  , tap Programs, tap
Pocket Excel.

2. Tap New to display a blank
document.

If you selected a template for new
documents in the Options dialog
box, that template appears with
the appropriate text and
formatting already provided.

Creating Pocket Excel documents

To create a new Excel document:
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To specify save options:

1. With the document open, tap
Tools.

2. From the pop-up menu, tap Save
Workbook As... to display the
Save As screen.

3. Change the file name by simply
typing a new one in the Name
field.

4. Tap the down arrow in the Folder
field to select a folder where you
wish to place the file.

NOTE If you do not wish to save your workbook to a different format,
but would like to change the file name, folder, and location of
your document, simply tap Edit from the command bar, then
tap Rename/Move... from the pop-up menu to make your
changes.

5. Tap the down arrow in the Type field to select a file format.

You can save the document you create or edit in a variety of formats:

• Pocket Excel (.pxl)

• Excel (.xls)

6. Tap the down arrow in the Location field to indicate the location of
your saved file, either in the main memory of your device, or in a
storage card, if available.

7. Tap OK when done.
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Securing your Excel document
If your workbook contains sensitive or confidental information, you can
protect it with a password.

To set a password for your workbook:

1. Open the workbook.

2. Tap Edit from the command bar,
then tap Password... to display
the password setting screen.

3. Type a password in the
Password field.

4. Re-type the password in the
Verify Password field.

5. Tap OK when done.

If you have set a password for your
workbook, a password screen
appears asking you to type your
password whenever you try to open
the workbook.

Type your password, then tap OK. If
you type in a wrong password, a
message appears telling you so.

NOTE DO NOT forget your password! You can not open your
workbook unless you type in the correct password.
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Tips for working in Pocket Excel
Take note of the following when working in large worksheets in Pocket
Excel:

• View in full-screen mode to see as much of your worksheet as
possible. Tap View, then tap Full Screen. To exit full-screen mode, tap
Restore.

• Show and hide window elements. Tap View, then tap the elements to
show or hide.

• Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View, then tap Freeze Panes. You might want to
freeze the top and leftmost panes in a worksheet to keep row and
column labels visible as you scroll through a sheet.

• Split panes to view different areas of a large worksheet. Tap View, then
tap Split. Drag the split bar to where you want it. To remove the split, tap
View, then tap Remove Split.

• Show and hide rows and columns. To hide a row or column, select a
cell in the row or column that you want to hide. Tap Format, then tap
Row or Column, and tap Hide. To show a hidden row or column, tap
Tools, then tap Go To, and type a reference that is in the hidden row or
column. Tap Format, then tap Row or Column, and tap Unhide.

For more information on using Pocket Excel, tap  , then tap Help.
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MSN Messenger
MSN Messenger on your device is an instant messaging program that
allows you to:

• See who is online

• Send and receive instant messages

• Have instant message conversations with groups of contacts

To use MSN Messenger:

You must have a Microsoft Passport™ account or a Microsoft
Exchange e-mail account.

You must have a Passport to use the MSN Messenger Service. If you
have a Hotmail® or MSN account, you already have a passport. Once you
have obtained either a Microsoft Passport or Microsoft Exchange account,
you are ready to set up your account.

Sign up for a Microsoft Passport account at http://www.passport.com.

Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com.

To launch MSN Messenger:

1. Tap  , then tap Programs.

2. Tap MSN Messenger.



Companion programs 5-15

Signing up

To sign in to MSN Mesenger service:

NOTE If you already use MSN Messenger on your desktop
computer, your contacts will show up on your device without
being added again.

1. Tap Tools then tap Sign in... from
the menu.

OR

Simply tap the Tap here to sign
in area.

2. In the sign-in screen, enter your
e-mail address and password.
Tap Sign In.
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Working with contacts
The MSN Messenger window shows all of your messenger contacts at a
glance, divided into Online and Not Online categories. From this view,
while connected, you can chat, send an e-mail, block the contact from
chatting with you, or delete contacts from your list using the pop-up menu.

To see others online without being seen, tap My Status in the Tools menu
and select Appear Offline.

If you block a contact, you will appear offline but will remain on the blocked
contact’s list. To unblock a contact, tap and hold the contact, then tap
Unblock on the pop-up menu.
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Chatting with contacts
Tap a contact name to open a chat window. Enter your message in the text
entry area at the bottom of the screen, or tap My Text to enter a preset
message, then tap Send. To invite another contact to a multi-user chat, tap
Invite in the Tools menu, then tap the contact that you want to invite.

NOTE To switch back to the main window without closing a chat, tap
the Contacts button. To go back to your chat window, tap
Chats and select the person whom you were chatting with.

To know if the contact you are chatting with is responding, look for the
message under the text entry area. For more information on using MSN
Messenger, tap  , then tap Help.



5-18 Chapter 5

Windows Media Player for Pocket PC
Use Microsoft® Windows Media Player for Pocket PC to play digital audio
and video files that are stored on your device or on a network. To switch to

Windows Media Player for Pocket PC, tap  , tap Programs, then tap
Windows Media.

Use Microsoft Windows Media Player on your desktop computer to copy
digital audio and video to your Pocket PC. You can play Windows Media
and MP3 files on your Pocket PC.

For more information on using Windows Media Player for Pocket PC, tap
 , then tap Help.

Indicates the progress
of the current track

Tap to play or pause

Tap to stop
Tap to play the previous track

Tap to play the next track

Slide to adjust volume

Tap to mute sound
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Microsoft Reader
Use Microsoft Reader to read eBooks on your device. Download books to
your desktop computer from your favorite eBook web site. Then, use
ActiveSync to copy the book files to your activated device. The books
appear in the Reader Library.

Each book consists of a cover page, an optional table of contents, and the
pages of the book. You can:

• Page through the book using the Up/Down control on your device, or by
tapping the page number on each page.

• Annotate the book with highlighting, bookmarks, notes, and drawings.

• Search for text and look up definitions for words.

The Guidebook contains all the information that you need to use the
software. To open  the Guidebook, tap Help on the Reader command bar.
Or, on a book page, tap and hold on the book title, then tap Help on the
pop-up menu.

To launch Microsoft Reader:

1. Tap  , then tap Programs.

2. Tap Microsoft Reader.
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Using the Library
The Library is your Reader home page. It displays a list of all books stored
on your device or storage card.

To open the library:

1. On the Reader command bar, tap Library.

2. On a book page, tap the book title, then tap Library on the pop-up
menu.

To open a book, tap its title on the Library list.

Tap to scroll through
the Library list

Tap to select
a sort order

Tap to search books
by author or title

Tap to navigate to
other parts of the
Reader

A list of books you
have stored appears
here

Getting books on your device
You can download book files from the Web. Just visit your favorite eBook
retailer and follow the instructions to download the book files.

Sample books and a dictionary ar also included in the MSReader folder in
the Extras folder on the Pocker PC Companion CD.

Use ActiveSync to download the files from your desktop computer to your
activated device as described in the Read Me file in the MSReader folder.
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Reading a book
Each book consists of a cover page, and optional table of contents, and
the pages of the book. Navigation options are listed in the bottom portion
of the cover page.

The first time you open a book, you will probably want to go to the first
page or to the table of contents, if there is one. Subsequently, whenever
you open a book, you will be automatically taken to the last page read.

In addition to the text, each book page includes a page number and the
book title.

You can also page through a book using the Up/Down control on your
device.
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Using Reader features
Reading a book electronically gives you several options not available with
paper books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on
the pop-up menu, as described below.

• Search for Text. Find text in a book by tapping Find on the pop-up
menu. Enter the word you want to search for, and tap the desired Find
option. Reader highlights found text on the page. To close Find, tap
outside the box. To return to your original page, tap the title then tap
Return on the pop-up menu.

• Copy Text. You can copy text form books that support this feature into
any program that accepts text. On a book page, select the text that you
want to copy. Then, tap Copy Text on the pop-up menu. The text can be
pasted into the program of your choice.

• Bookmarks. When you add a bookmark to a book, a color-coded
bookmark icon appears on the right margin. You can add multiple
bookmarks to a book. Then, from anywhere in the book, tap the
bookmark icon to go to the bookmarked page.

• Highlights. When you highlight text, it appears with a colored
background.

• Notes. When you attach a note to text, you enter the text in a note pad
that appears on top of the book page. A Note icon appears on the left
margin. To show or hide the note, tap the icon.

• Drawings. When you add a drawing, a Drawing icon appears on the
bottom-left corner of the page, and drawing tools appear across the
bottom of the page. Draw by dragging your stylus.

NOTE To see a list of a book’s annotations, including bookmarks,
highlights, text notes, and drawings, tap Annotations Index
on the book’s cover page. You can tap an entry in the list to
go to the annotated page.

Removing a book
When you finish reading a book, you can delete it to conserve space on
your device. If a copy of the book  is stored on your desktop computer, you
can download it again at any time.

To remove a book from your device, tap and hold the title in the Library list,
then tap Delete on the pop-up menu.




